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DEFINITIONS 

ArcMap/ArcGIS Desktop: A geospatial desktop application licensed and developed by 
ESRI software. Used to examine, edit, create, and analyze spatial data. As of 2019, is 
being replaced by ArcGIS Pro. Not compatible with Macintosh operating systems. 

ArcGIS Pro: Similar to ArcMap, ArcGIS Pro is a newer geospatial processing program 
licensed and developed by ESRI with 64-bit architecture and some additional built-in 
analysis features and increased compatibility with ArcGIS online services. ArcGIS Pro is 
the newer version of ArcMap and will replace it over time. Not compatible with 
Macintosh operating systems. 

Cooling Tower: A heat removal device that uses water to transfer waste heat into the 
atmosphere. Cooling towers are typically used to provide heating and air conditioning. 
They are very diverse among models, shapes, sizes, and heights and serve multiple 
building types and uses.  

Geodatabase: A collection of files in a folder that can store, query and manage both 
spatial and non-spatial data.  

Google Earth Pro:  A free geospatial application displaying a combination of satellite 
and aerial images of the earth as a three-dimensional globe at different catalogued time 
points. Google Earth superimposes satellite imagery with aerial imagery. Google Earth 
is compatible with most GIS products and can be used for importing global positioning 
system (GPS) data, finding geographical features, and exporting locational data.  

KML File: Keyhole Markup Language (KML) is a file format used for Google Earth. It is 
an extensible markup language (XML) notation for geographical and visualization data 
with internet-based maps and 2D/3D Earth browsers. This is the default file type for 
spatial data in Google Earth. 

KMZ File: A file format used for Google Earth placemark files. Stands for Keyhole 
Markup Language Zipped. Similar to a KML file, the KMZ file is a compressed (zipped) 
version that can be used to transfer large Google Earth locational data to other 
programs.  

Legionnaires’ Disease: A severe pneumonia caused by inhalation or aspiration of 
Legionella bacteria.  

Shapefile: A file format used for storing geometric location and attribute information that 
is compatible between most GIS programs. Shapefiles will end with .shp after the file 
name, but for a shapefile to work properly, additional associated files (i.e., ending in .dbf 
and .shx) that contain critical information are stored in the same workspace as the 
shapefile.  
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ABBREVIATIONS 

CDC  U.S. Centers for Disease Control and Prevention 

CDPH  California Department of Public Health 

CT  Cooling Tower 

DIS  Disease Investigations Section 

ESRI  Environmental Systems Research Institute 

GE  Google Earth 

GIS  Geographic Information System 

GRASP Geospatial Research, Analysis, and Services Program  

IDB  Infectious Diseases Branch  

KML   Keyhole Markup Language 

KMZ  Keyhole Markup Language Zipped 

LD  Legionnaires’ Disease 

OC  Orange County  

OCHCA Orange County Health Care Agency 

PDPH  Philadelphia Department of Public Health 
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BACKGROUND 

INTRODUCTION 

Legionnaires’ disease (LD) is a severe, potentially life-threatening pneumonia with an 
associated fatality rate of close to ten percent. Pontiac fever (PF) is a milder, self-
limiting influenza like illness. LD and PF are collectively known as legionellosis and can 
be caused by over 50 different species of Legionella bacteria, most commonly L. 
pneumophila and L. longbeachae.1, 2 Legionella bacteria live in natural freshwater 
bodies as well as in soil environments, and most commonly cause human disease when 
inhaled in contaminated, aerosolized water droplets. The annual incidence of 
legionellosis in the United States has been increasing, with a rate of 2.29 per 100,000 
population in 2017.3, 4 

Cooling towers (CTs) are units commonly used to cool large spaces and disperse large 
volumes of hot water into the air in the process. They are also prone to Legionella 
bacteria colonization, and have been extensively linked to outbreaks and sporadic, 
community-acquired cases of LD.5 Investigations of CTs are an important component of 
LD outbreak management. However, identifying and distinguishing CTs from other 
cooling units and structures can be difficult and time-consuming. For more details on 
CTs, see B. INTRODUCTION TO COOLING TOWERS. This document describes a 
protocol for using satellite imagery as a tool for the identification CTs. 

For illustrative purposes throughout this document, we will reference a CT mapping 
project conducted as a collaborative effort between the California Department of Public 
Health (CDPH) and the Orange County Health Care Agency. The goal of this project 
was to map all CT locations in Orange County (OC) in order to examine the relationship 
between CTs and sporadic cases of LD among residents living in OC from January 1, 
2014 to December 31, 2018.   

GOALS 

This guide is meant to (1) provide background knowledge of CT systems and model 
types, (2) describe the steps to identify CTs using satellite imagery, and (3) describe 
methods used to prepare spatial data of CTs for use in spatial analysis.  

Identifying CTs on digital maps (mapping of CTs) requires a basic understanding of CT 
models and mechanics, as well as a basic knowledge of Geographic Information 
Systems (GIS) products and satellite and aerial imagery. With guidance from the U.S. 
Centers for Disease Control and Prevention (CDC) Agency for Toxic Substances and 
Disease Registry, Geospatial Research, Analysis, and Services Program (GRASP), 
CDPH has created this protocol for internal use to identify and/or map the location of 
CTs in California.  
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The purpose of the “Cooling Tower 101: How to use Satellite Imagery to Identify Cooling 
Towers” protocol is to provide a step-by-step guide on CT identification by scanning 
regional satellite/aerial imagery. This protocol includes example images, reference 
diagrams, and a list of resources for understanding CT identification to support future 
satellite imagery projects. This guide presumes minimal pre-existing knowledge of either 
GIS or CTs.  

IMAGES AND PRODUCTS DISCLAIMER 
Unless otherwise noted, the images of CTs or CT mechanisms included in this 
document are for example only, intended to familiarize users with the variety of 
structures that may be found while conducting searches for CTs. Any mentions of 
brand-name products are for informational purposes only; use of product names or 
images in this document does not imply commercial endorsement by CDPH, nor does 
CDPH take credit for the images included in this document. Images are used in 
accordance with fair use, as they are provided for teaching and research purposes only.  

STRUCTURE OF THIS DOCUMENT 

The following document is organized into three main sections: (1) Pre-scan (pre-
requisites before scanning for CTs), (2) Scan (process used to scan for, identify and 
label CTs), and (3) Post-scan (data processing and analysis). Each section should be 
used in order and, if possible, iteratively to fully understand CT models and methods for 
identification. At the end of the document, we have included additional resources 
including presentations, videos, guides, and GIS maps to help structure CT 
identification. Resources from various partners at state and local health departments 
that offered assistance in developing this protocol are embedded in the final sections of 
the document. We have also included recommendations for starting a CT scan, and 
lessons learned to help streamline CT identification.  

Lastly, a separate Cooling Tower Identification Guide supplement is provided, which 
includes specific details, images, and examples to help distinguish and identify CTs 
from non-CTs. 

OVERVIEW OF THE COOLING TOWER IDENTIFICATION PROCESS  

The three main steps to identify CTs using satellite images are highlighted in Figure 1 
below.  

Step 1: Pre-Scan – Understanding CTs and other pre-requisites before scanning 

Step one discusses the mechanics of CTs and common model types; this is 
crucial to understanding how CTs may differ in appearance from other 

https://www.copyright.gov/title17/92chap1.html#107
https://www.cdph.ca.gov/Programs/CID/DCDC/CDPH%20Document%20Library/CTIDGuideSupplement.pdf
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mechanical devices on buildings. Software used for the project and options for 
alternative satellite imagery are also discussed. 

Step 2: Scan – Using satellite imagery to find CTs 

This section includes step-by-step methods that can be used for CT 
identification, including creating strategies to systematically evaluate geographic 
regions for CTs.  

Step 3: Post-Scan – Processing of data for analysis 

The post-scan section documents how to convert and analyze data products with 
GIS, including components of saving a Google Earth (GE) file in the correct file 
format and converting it to a file format compatible for GIS. The last chapter 
includes recommendations, lessons learned, and limitations of using satellite 
imagery for CT identification.  

 

Figure 1 : Overview of CT Identification. 
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1. PRE-SCAN 

A. SOFTWARE REQUIREMENTS 

The software needed to follow this guide and conduct a CT scan include: 

1. Satellite imagery streaming service 
a. Google Earth Pro, or 
b. See the alternative section in High Resolution Imagery options below 

2. GIS spatial mapping program  
a. ArcMap version 10.5+, or 
b. ArcGIS Pro version 2.1+, or 
c. ArcGIS Online, or 
d. QGIS  

3. Microsoft Excel  

Install each program as a desktop application directly to the computer being used for 
the analysis.  

I. GOOGLE EARTH 
Google Earth Pro (GE) was chosen for the CT-identification portion of this project 
because: 

a) The combined satellite and aerial imagery allow for 6-inch resolution.  
b) Some 3D reconstructions of buildings are available, providing orthogonal views. 
c) It is freely available. 
d) It provides easily accessible, catalogued, time-stamped imagery from prior years. 

It is not recommended to use GE launched from a web browser. For PCs, Macintosh, or 
Linux, GE can be directly downloaded as a free application to computer desktops. It is 
recommended to use GE on desktop as it is easier to store files than the web 
application. For those unable to access GE, please see the section below for alternate 
resources for High Resolution Imagery.  

HIGH RESOLUTION IMAGERY  

Different images are needed for different parts of this protocol. The most image-
intensive task is CT identification, as CTs can be small and the identifying features on 
them even smaller. To reliably identify CTs, it is best to use a service that provides 
resolution of at least 6 inches per pixel.  

Currently available satellite images have a resolution limit of greater than 12 inches. 
Thus, a combination of satellite and aerial (i.e., drone, plane, helicopter) imagery is 

https://www.google.com/earth/versions/
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necessary. Additionally, orthogonal views are extremely helpful as many CTs are on the 
sides of buildings or otherwise obscured. Imagery services that provide updated, time-
stamped and current images or catalogued images from prior years is helpful, though 
not mandatory, for examining CTs. 

There are a number of publicly and privately available high-resolution satellite imagery 
resources. In our exploration of different image sources, we were unable to find a 
readily available free resource with high enough resolution that allowed for CT 
identification, with the exception of GE. This is likely because most publicly available 
imagery is from satellites and limited in resolution to 12 inches, whereas GE combines 
satellite imagery with higher-resolution aerial imagery. However, it is possible that such 
resources exist or that investment in private satellite imagery can be necessary 
depending on the planned use. As a streaming web-service, reliance on GE images can 
be limiting for certain types of spatial analyses that require downloadable image data. 

Below is a non-exhaustive list with a few comments on each source.  

• DigitalGlobe: Private. High-resolution satellite images, now with some 
partnerships with ESRI to provide their basemaps. Includes QuickBird satellites 
and GeoEye. Available at https://www.maxar.com/.  

• US Geological Survey: Public. Collects Landsat data, Aster, NASA (MODIS, 
AVHRR) and other publicly available aerial and satellite imagery, digital elevation 
models, topography maps; this a great place to start looking for resources. 
Available at https://www.usgs.gov/.  

• National Oceanic and Atmospheric Administration (NOAA): Public. Jason-2, 
GOES, and high-quality atmospheric data, also good for remote sensing. 
Available at https://www.nesdis.noaa.gov/OPPA/jason2.php.  

• European Space Agency (ESA): Public. Sentinel data, which gives more bands 
(useful for remote sensing) and has resolution equal to Landsat. Available at 
http://www.esa.int/.  

• State, county, or city GIS clearinghouse: These may be the best repositories 
for high-resolution imagery as they are often used for fine-resolution work (i.e., 
public planning, business, utilities groups). Availability and access will depend on 
the state or county.  

• EagleView/Pictometry: Private. Both high-resolution satellite and aerial imagery, 
and oblique images. Likely most suitable dataset for CT identification (though we 
were unable to obtain any images to trial). Available at 
https://www.eagleview.com/product/eagleview-reveal/.  

https://www.digitalglobe.com/
https://www.usgs.gov/
https://www.nesdis.noaa.gov/OPPA/jason2.php
http://www.esa.int/
https://www.eagleview.com/product/pictometry-imagery/
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• Other: A summary of other private imagery services, including those that offer 
aerial imagery, is available on the AppGeo imagery comparison webpage at 
https://www.appgeo.com/imagery-comparison-satellite-aerial. 

 *Protocols for this document use GE and may not apply to other imagery sources.  

II. GIS SPATIAL MAPPING PROGRAMS  
Most available GIS software are suitable (i.e., ArcMap, ArcGIS Pro, ArcGIS online, or 
QGIS). All processes included in this protocol can be done with any of these programs, 
though this protocol is written with demonstrations from ArcMap. However, there are 
important distinctions between these programs:  

• There is minimal functional difference between ArcMap and ArcGIS Pro: 
o ArcGIS Pro is the newer, 64-bit version of ArcMap. ESRI will likely phase 

out support for ArcMap over the next few years.  
o The computing resource intensity of ArcGIS Pro is higher and thus it may 

not run as smoothly on certain desktops or with certain versions of 
Windows OS. 

• ArcGIS Online is a web-browser and does not require a link to either desktop 
versions of ArcMap or ArcGIS Pro, however its GIS capabilities are more limited.  

• Licensing for ArcGIS online varies, and many analyses done using ArcGIS online 
may cost ESRI ‘credits’ whereas the same function on the desktop ESRI platform 
does not cost ‘credits.’ 

• QGIS is a free, open-source GIS software that works well on Macintosh as well 
as PCs; it has the same general functionality as ArcMap or ArcPro, though many 
of these are through open-source plug-ins rather than built-in functionality.  

Choice of software will likely depend on what is being licensed and available.  

B. INTRODUCTION TO COOLING TOWERS 

A CT is a heat rejection device that sends waste heat into the atmosphere. The purpose 
of a CT is to take in hot water that has been heated by an industrial system, process, 
building or space, effectively lower the temperature, and send cool water back to once 
again fulfill cooling needs.  

Nearly all CTs run on the same overall mechanical design. Inside a CT, water and air 
mix to lower the temperature of outgoing water. Figure 2 shows a simplified version of 
how water moves through a CT.  

https://www.appgeo.com/imagery-comparison-satellite-aerial/
https://www.appgeo.com/imagery-comparison-satellite-aerial
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Figure 2: CT cooling process. 
Hot water typically enters a CT through piping connected to air conditioning units, 
condensers, and other industrial machinery from a building.6 After hot water is pumped 
into the CT structure, it moves through nozzles that spray incoming water onto a CT fill 
(Figure 2, Figure 3). Fill is a type of medium used to increase the surface area of water.7 
At the same time, outside, ambient air is pulled in from openings in the CT sides and/or 
bottom and circulates through the fill, allowing hot water and air to mix and decrease the 
overall water temperature. This air is pulled through the CT by a motor-driven, electrical 
fan(s), on the top or side of the CT. As the water temperature lowers, some amount of 
hot water rises (evaporative mist) and is ejected by the CT fan (CT drift). Cooled water 
moves down the CT structure and empties into a bottom basin. If the water is not 
effectively cooled, it will recirculate in the CT until it reaches the ideal temperature.   

Given this mechanism of cooling hot water, CTs share similar traits with each other 
regardless of their overall design or appearance. These traits can be advantageous for 
identification (see Cooling Tower Identification Guide supplement for additional CT 
appearance notes): 

• Presence of a fan to draw air in and circulate it through the fill 
o Fan usually is on top of the unit or on the side 
o Fan is usually large, both in absolute size and also relative to the CT unit 

to move large amounts of air slowly through the unit 
o Air does not need to circulate quickly in CTs; thus, the fans tend to be 

slower moving (and blades often can be seen visibly on still satellite 
images, rather than as a blur of fans) 

• Often with open sides and visible fill (Figure 3: left image) 

https://www.cdph.ca.gov/Programs/CID/DCDC/CDPH%20Document%20Library/CTIDGuideSupplement.pdf
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• Many water lines running to and from the CT, to move hot and cooled water 
(Figure 10) 

   

I. COOLING TOWER DRIFT 
Water that is ejected from a CT fan with evaporative mist is called CT drift (Figure 4). 
Many of the newer CT models have CT drift eliminators to prevent excess water loss. 
However, CT drift can occur regardless of model type or drift eliminator. In comparison 
to water vapor that will naturally escape a CT fan and is thought to be harmless to the 
environment, CT drift consists of small water droplets that can contain chemicals, 
minerals, and bacteria harmful to the environment.8  

 

Figure 4: CT evaporative mist (left) showing small amounts of water lost by 
evaporation versus CT drift (right) showing small droplets of water ejected from 
CT by a fan. 

II. COOLING TOWERS AND LEGIONNAIRES’ DISEASE 
Legionella bacteria are naturally occurring in freshwater environments and can 
proliferate in stagnant and hot water. CTs are of special interest for LD control because 
they circulate massive volumes of hot water (1,000-6,000 gallons/minute) and provide 
favorable conditions for Legionella growth, including optimal growing temperatures and 

Figure 3: Examples of CT fill (Left: worker spraying fill on side of CT; Middle: fill 
removed from CT; Right: image of fill showing movement of water and air). 
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recirculated water.2 If CTs are not maintained and properly disinfected, Legionella can 
become aerosolized through CT fans and expose individuals to infection. The distance 
that the subsequent Legionella-contaminated, aerosolized water can travel varies with 
CT height, fan size, relative atmospheric humidity, temperature, and wind speed and 
direction.9 

This ability for CTs to serve as amplifiers for Legionella growth and to also aerosolize 
large volumes of water over long distances explains why CTs are the most extensively 
implicated cause of large LD outbreaks.5 Smaller evaporative coolers have less 
commonly been linked to outbreaks due to the much lower volumes of aerosolized 
water. Closed-circuit coolers and air conditioners are not designed to generate any type 
of aerosol, and while they have been linked to cases, are not thought to be high risk for 
causing LD.5 

III. TYPES OF CTS 
There are two different types of CT structures that are necessary to delineate for 
purposes of looking at exposure to CT drift: open circuit CTs and closed circuit CTs. A 
closed-circuit CT does not have an opening fan blade that allows water or air to escape 
the structure. Open-circuit CTs are those with exposed fans and fills. For identifying CTs 
that may expose individuals to CT drift and Legionella, we focused on scanning for 
open-circuit CTs.  

While open-circuit CTs also come in numerous shapes and sizes, they all follow similar 
general mechanics. Some examples of common, open-circuit models are shown in the 
following pages, grouped by shape and size: Rectangular and Square CTs, Round 
Shape CTs, and Large Hyperboloid Forced Draft and Induced Draft CTs. Also included 
are images of CTs with fans on their sides, and CTs of different colors and with 
attached water pipes. 
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RECTANGULAR AND SQUARE CTS 
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RECTANGULAR AND SQUARE CTS, CONT. 
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RECTANGULAR AND SQUARE CTS, CONT. 
 

 

 

Figure 5: Rectangular and square CTs, the most common types of CT. (Images  
of branded CTs courtesy of Delta Cooling Towers and SPX Cooling 
Technologies.)  

  

https://deltacooling.com/
https://spxcooling.com/
https://spxcooling.com/
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ROUND SHAPE CTS 
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ROUND SHAPE CTS, CONT. 

Figure 6: Round designs of open CTs, often substantially smaller than other CTs 
and more commonly on the ground. (Images of branded CTs courtesy of Delta 
Cooling Towers and Cooling Tower Systems.)  

https://deltacooling.com/
https://deltacooling.com/
https://www.coolingtowersystems.com/
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LARGE HYPERBOLOID FORCED DRAFT AND INDUCED DRAFT CTS 

Figure 7: Large hyperboloid shaped CTs are typically easy to find on a satellite 
images but are much less common; these models are used for very large 
industrial plants.
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CTS WITH SIDE FANS 

Figure 8: CTs with side fans or other less common fan configurations. 
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COLORED CTS AND WATER PIPES 
Aside from silver/metallic CTs, other common colors for CTs are blue and green (Figure 
9). These colors can also often be seen on pipes to represent the presence of a water 
source or water supply (Figure 10). Other companies have used blue and green to 
represent newer models that have shells with resins that are “anti-mircrobial.” For more 
information on types of anti-microbial CTs, visit the Delta Cooling Towers, Inc. Anti-
Microbial Cooling Towers information webpage 
(https://deltacooling.com/products/cooling-towers/anti-microbial-cooling-towers) (for 
informational purposes only; CDPH does not endorse these products). 

Figure 9: Colored CTs. 

Figure 10: Colored water pipes. 

https://deltacooling.com/products/cooling-towers/anti-microbial-cooling-towers
https://deltacooling.com/products/cooling-towers/anti-microbial-cooling-towers
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The following are additional references on CTs: 

• “Buildings Cooling System” 
(https://www1.nyc.gov/assets/buildings/pdf/evaporative_cooling.pdf) 

• “What is a Cooling Tower” (https://www.cti.org/whatis/coolingtowerdetail.shtml) 

 
More information and videos that explain CT mechanics and structure are available 
online. 

For a list of CT manufactures please visit the Cooling Tower Institute webpage 
(https://www.cti.org/directories/manufacturers.php). 

 

 

  

https://www1.nyc.gov/assets/buildings/pdf/evaporative_cooling.pdf
https://www.cti.org/whatis/coolingtowerdetail.shtml
https://www.cti.org/directories/manufacturers.php
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2. SCAN
After becoming familiar with CT models and shapes, the following section lists the 
methods for using GE to conduct and set up a systematic CT scan, identify CTs, and 
label CTs for later use. 

Figure 11: A CT scan starts with defining a study area of interest. The second 
step is creating a strategy to help track progress during the scanning process. 
The next steps, the bulk of the scanning process, include learning how to scan/
identify CTs structures, and label CTs to track progress. The final step is to 
refine methods used and review CTs identified. The scan process is iterative and 
can be repeated to increase accuracy of results and identify changes to maps of 
CT locations as time passes.

Define area of 
interest

Create a scan strategy 
and grid model

Scan for CTs
Label CT features and 

take snapshots

Revise and replicate 
scan process
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A. DEFINE AN AREA OF INTEREST

Before beginning the scan, define the area of interest that will be examined for CTs. 
This could be defined by administrative or other boundaries (i.e., a county, city, 
neighborhood, street block, or the perimeter of an outbreak area). A consideration when 
defining an area of interest is whether a shapefile already exists to help delineate 
borders within GE (Figure 12); presence of a pre-existing shapefile will make the GIS 
workspace easier to establish. 

There are no limits on the geographical boundaries for an area of interest, but it will be 
easier to learn the process by starting with a smaller area of interest, such as a 
neighborhood or a small block, and then revising the scan strategy for a larger area. 
The larger the study area, the more time it will take to identify CTs. For reference, below 
we estimate the amount of time it will take one experienced person to identify CTs 
based on common area geographies. 

Figure 12: Common types of geometries for shapefiles are neighborhoods, 
cities, and census tracts. 

Geographical Area Approximate Time to Complete a CT Scan 

Small block or census tract 2-3 hours

Small, non-dense city 1 month 

Large city (over 1 million people) 2-4 months

Small county 2-5 months

State 12-48 months
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OPTION 1: DESIGNATING AN AREA OF INTEREST IN GOOGLE EARTH 

* For all demo protocols, Orange County, California was used as the area of interest.

 Download and open Google Earth Pro
 Zoom to the area of interest

o In the top left search bar type the area of interest and click ‘Search’

o If the study area is not available from the search bar or the study area is
unconventional, then use available zoom tools:

 Zoom using computer mouse scroll and mouse pointer

 Zoom using the slider icon at the top right corner of the screen

 If able, zoom to the study area on the map, then right click the location and select
‘Save to My Places’

o The name of the study area should now be seen in the contents bar on the
left side, under ‘My Places’

Figure 13: Study area saved under ‘My Places’ in GE. 

https://www.google.com/earth/versions/#earth-pro
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 If the defined study area was not available in the search bar, the drawling tools
can be used instead to outline the study boundaries or drop a pin.

o To drop a pin for the study boundary, click the ‘Placemark’ icon  on the
top menu bar. Drag the placemark to the study area of interest. A small
box should pop-up. Under name, label the placemark with the name of the
study area.

o To outline the study boundary, click ‘New Polygon’ icon  at the top 
menu bar

o If the study area does not fit the shape for drawling a polygon, use the free

hand ‘New Path’ tool icon  and draw the study boundaries.

o Alternatively, any of the three options can be selected using the ‘My
Places’ tab.
 Under ‘My Places’ > right click > select ’Add’ > and choose to add

‘New Polygon’, ‘New Path’ or ‘Placemark.’

Figure 14: ‘Placemark’ added to indicate a study area in GE. 

 Save area boundaries.
o Once the study area has been designated, save the location so that the

point can be referenced every time GE is reopened.



29 
 

 To save > right click ‘My Places’ > Select ‘Save Place As.’ 

Each time the GE file is opened, the study area should be labeled under ‘My Places,’ 
and the file should be saved. If the file is opened from a saved place, it typically opens 
under the ‘Temporary Places’ tab, and from there can be moved and dragged to ‘My 
Places.’ Having the file under ‘My Places’ allows for the file to be immediately moved to 
the location where the user left off each time the program is opened.  

OPTION 2: IMPORT THE AREA OF INTEREST DIRECTLY USING A 
SHAPEFILE  

• If the study area boundaries have already been established, or if the user has a 
shapefile, they can be imported directly into GE. For example, if the study area is 
counties in the San Francisco Bay Area, then the shapefile can be downloaded 
online from the United States Census Bureau.  

o Once the shapefile has been downloaded and saved, open the shapefile 
in GE and move it from the ‘Temporary’ folder to ‘My Places.’  

*For additional info on databases of available shapefiles, see Analysis Resources 
under Additional Resources.  

 

B. CREATE A GRID MODEL FOR SCANNING 

The purpose of a grid model is to help track progress of each CT scan. Grid models are 
most useful for larger study areas and may not be necessary if scanning smaller regions 
(i.e., one census block). We recommend using a grid model if: (1) the scan is estimated 
to take more than 30 minutes, (2) if more than one user will be scanning the same area, 
or (3) if the study boundaries are not a typical geometric shape. If the study area is 
small and a grid model is not needed, then skip to Strategy to Organize Scanning. 
There are several ways to create a grid model that will be compatible with GE, and 
additional links are provided at the end of this section. The following steps describe how 
to create one type of grid using ArcMap (the methods in ArcPro should be similar).   

1. Download and open ArcMap 10.5. 
2. Import downloaded shapefile for the study area of interest. 
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Figure 15: A study area boundary created by importing a shapefile directly into 
ArcGIS.  

a. If the study area is the boundary of a state, county, or a city, then
shapefiles should be available from the United States Census Bureau
TIGER database (https://www.census.gov/geographies/mapping-
files/time-series/geo/tiger-line-file.html).

3. Open the ‘ArcToolbox’ > ‘Data Management Tools’ > ‘Create Fishnet.’

a. Note: Organizational licenses for ArcMap vary, and some of the features
needed for this step might be locked. If this occurs, users should contact
their organization to have fields enabled.

4. In the ‘Create Fishnet’ tool, users can customize the grid layer to the size that
they want (for OC, we used a grid size of 200 meters x 200 meters). See Grid
Model Scanning for more details on choosing an appropriate grid size.

a. For example:

i. Output feature class: Grid_’name of area’
ii. Template Extent: Same as layer ‘name of your shapefile layer’
iii. Cell size height: 5
iv. Cell size width:  5
v. Number of rows: 0 (zero is a default setting which automatically

creates rows)
vi. Number of columns: 0
vii. Check create label points
viii. Geometry type: Polygon

https://www.census.gov/geographies/mapping-files/time-series/geo/tiger-line-file.html
https://www.census.gov/geographies/mapping-files/time-series/geo/tiger-line-file.html
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Figure 16: ‘Create Fishnet’ window in ArcGIS. 

5. After running the grid model, convert it to a KML file, and import the grid into GE.

a. In ‘ArcToolbox’ > ‘Conversion Tools’ > To KML > input the grid layer and
pathway to where the file will be stored.

6. In GE > ‘File’ > ‘Open’ > navigate to the saved KML grid layer.
7. If using ArcGIS Pro, use the ‘Generate Tessellation’ tool. Under ‘Extent,’ choose

a layer with whatever area boundary is being used, or just zoom into the area of
interest and use the screen extent. For shape type, choose square.
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For additional reference on grid models use the following videos and guides: 

“How to Create Grid in ArcGIS with Required Dimension”:  

https://www.youtube.com/watch?v=7o01Y9bWwFw 

“ArcGIS Creating Polygon Grid - Create Fishnet”: 
https://www.youtube.com/watch?v=v3U3DJ2JZXg 

“ArcGIS Desktop: Creating a Polygon Grid with Specified Coordinates”: 

http://desktop.arcgis.com/en/arcmap/latest/extensions/data-reviewer/creating-a-

polygon-grid-with-specified-coordinates.htm 

“Work with a Grid in ArcGIS Pro”: https://www.youtube.com/watch?v=Tm-k5d3Ar54  

“Michigan Technological University: Creating a Regular Grid for Point Sampling”: 

http://gis.mtu.edu/wp-content/uploads/2012/06/Regular_Sampling_Tutorial.pdf  

 

ArcPro Guides: 

“ArcGIS Pro - Grid Index Features”: https://pro.arcgis.com/en/pro-app/tool-

reference/cartography/grid-index-features.htm 

“ArcGIS Pro - Add a Grid”: https://pro.arcgis.com/en/pro-app/help/layouts/add-a-
grid.htm 

https://www.youtube.com/watch?v=7o01Y9bWwFw
https://www.youtube.com/watch?v=v3U3DJ2JZXg
http://desktop.arcgis.com/en/arcmap/latest/extensions/data-reviewer/creating-a-polygon-grid-with-specified-coordinates.htm
https://www.youtube.com/watch?v=Tm-k5d3Ar54
http://gis.mtu.edu/wp-content/uploads/2012/06/Regular_Sampling_Tutorial.pdf
https://pro.arcgis.com/en/pro-app/tool-reference/cartography/grid-index-features.htm
https://pro.arcgis.com/en/pro-app/help/layouts/add-a-grid.htm
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C. STRATEGY TO ORGANIZE SCANNING 

A scan strategy is the process used to track progress and easily identify which areas 
have already been scanned for CTs and which areas still need to be scanned. Forming 
a scan strategy is simple and based on what will best help to track the overall scanning 
process. Two model suggestions are provided below: a scan strategy using census 
tracts and one using grid models. Building parcel data (i.e., Landvision) can also be 
incorporated to help prioritize scan areas, described in Parcel Data / Landvision.   

I. CENSUS TRACT SCAN STRATEGY 
This strategy uses the census tract boundaries to help define the scanning ‘work space.’ 
This is often used in combination with the grid model approach (see Create a Grid 
Model for Scanning). By itself, a census tract approach is less systematic than a grid 
strategy. However, if the work area is small (i.e., a few census tracts), then this method 
can be used on its own.  

Some additional pros and cons of this method: 

• Pros:  

o Census tract boundaries are readily available online. 
o The overall scan area may fall more neatly into census tract boundaries 

rather than county or ZIP code. 
• Cons: 

o Census tracts are quite varied in size and keeping track of progress within 
each census tract can quickly become difficult (it is easy to miss areas or 
repeat work). 
 

The following steps describe how to use census tract borders to organize 
scanning and track progress:  
 

1. Open the previous GE file with the area of interest saved. Be sure to also 
download and open the shapefile that has the study area with census tracts.   

2. Move the file from ‘Temporary Places’ to ‘My Places’ to permanently save within 
the project. 

3. Right click the ’Census’ layer > ‘Properties’ > ‘Style and Color’ > Change fill color 
to ‘no fill’ > Change outline color to be more visible and increase the outline 
width.   
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Figure 17: Study area with census tract borders added. 

4. Next, zoom into one of the census tracts (this is one scanning strategy, using
census tracks as boundaries).

5. Within each census tract, start by filling each screen to scan right to left. Then,
scan down, and lastly scan again left to right. This process of moving across the
screen continues until the entire census tract has been scanned.

Figure 18: Zoomed-in view of a study area census tract, with arrows indicating 
the recommended scan path.  
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After each census tract is completed, mark the center of the census tract with a pin to 
easily keep track of areas that have been scanned. 

Figure 19: Census tract for which scanning is complete, as indicated by a pin. 

II. GRID MODEL SCANNING
Using a grid model for scanning may be easier and more systematic, as grids will have 
a set shape. An effective strategy for larger areas is to use a combined grid and census 
tract strategy; within census tracts, a grid is used to track scanning progress while 
overall progress towards completion of a county is tracked by completion of census 
tracts. Grids can be modified to different sizes with the main purpose being to prevent 
losing track of which buildings have already been scanned and which have not. This 
means grid sizes can vary depending on user preference. One strategy might be to 
zoom into a high enough resolution sufficient to identify CTs. Using that screen size as 
reference, a single grid square would be the same size as the screen. Thus, once a 
single screen is finished, the user can pan to the next grid square without duplicating 
work or missing buildings (Figure 20). 
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Figure 20: Sample grid/fishnet over OC. 

Practically speaking, users will zoom in and out multiple times depending on what types 
of buildings are being scanned. Additionally, a single-screen grid size can be impractical 
as the number of grids needed to cover an area can be quite large. A compromise then 
might be a grid size that covers four screens (i.e., two vertical screens and two 
horizontal screens; Figure 21). 
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Figure 21: Each grid square (yellow squares) can be divided into four zoomed-in 
images. Starting in the top left corner of the grid square, the first entire zoomed-in 
image (A) can be scanned without moving the map around the screen. Once that 
zoomed-in image is completed, the map is panned to the right and the second 
zoomed-in image is completed (B). In this manner, the grid square can be 
systematically completed while only moving the map 4 times (A> B > C> D). 

For the OC CT project, a grid size of 200 meters x 200 meters (40,000 square meters) 
was used. At this size, one grid square could be completed by panning the monitor only 
4-8 times, with variation depending on what resolution was being used (Figure 21).  

A B 

C D 
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Experiment with larger or smaller grid sizes to see what works best; the trade-off is 
between load times in GE and grids being small enough to help divide up work 
efficiently.  

III. CREATING A GRID 

See Create a Grid Model for Scanning for details on creating a grid. 

IV. PARCEL DATA / LANDVISION 
Parcel data from Landvision (Digimap Lightbox) can be used to reduce workload. 
Landvision parcel data provide information on the zoning details for parcels. CTs are 
generally not found in areas zoned for single family homes (in our OC CT mapping 
project, no CTs were found in areas zoned for single family homes). So, one use of 
Landvision parcel data could be to select all parcel zone types except those for single 
family homes. By identifying parcels not zoned for single family homes, efforts can be 
focused on areas of higher yield, and the risk of missing retail or other establishments 
hidden in residential areas can be decreased. Whether CTs could exist on single family 
homes in areas outside of OC is unknown and use of parcel data should be tailored to 
the region of interest after an initial pilot scan. Additional filters could be used as well 
and should be explored. 

USING LANDVISION 
Landvision data are not freely available, but some government agencies pay for 
ongoing access. Users may have to work with their information technology (IT) teams to 
arrange access to Landvision data.  

After launching the Landvision web application, first choose the property types on which 
CTs are more likely to be used. For our purposes, we chose all zone types except for 
those containing single family homes. Since Landvision highlights building types 
selected (rather than buildings that are excluded), we chose to exclude single family 
homes (rather than to include single family homes and exclude all other building types) 
so that we would focus on visually highlighted areas (Figure 23). The following steps 
describe how to use Landvision data to prioritize scan areas.   

1. First, choose the area of interest. Landvision will automatically show all parcels 
meeting the search criteria on the screen, and it is best to minimize the number of 
results to reduce processing time. Additionally, the maximum number of results that 
can be exported to a shapefile is 500, which is a very small number. One way to 
address this is to reduce the size of the area of interest (and repeat this process 
numerous times). Alternatively, keep the area the same, and instead group the types 
of property (i.e., only show industrial buildings and then, only hospitals and hotels).  
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Figure 22: List of property types as shown in Landvision.  

2. Once there are fewer than 500 ‘visible search results,’ export to a shapefile using the 
‘Copy to Markup’ option that is within the icon of an arrow pointing down next to the 
‘Add to List’ button. As long as there are fewer than 500 results, they can be copied 
to a markup layer, and then extracted as a shapefile in the layer options.  

3. The copied layer will appear on the layers menu as ‘Search Results: Property 
Search’ and in the icon next to that layer, choose ‘Extract’ and the shapefile 
download will begin in the browser. 

4. Once downloaded the shapefile(s) has been downloaded, import this file into GE. 
Once loaded, change the borders of the parcel data into a color that is easy to see 
(e.g., bright green) with transparent filling. Then, when scanning, users will be able 
to quickly focus only on areas that light up, potentially saving time and reducing 
fatigue. 
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Figure 23: Example of highlighted Landvision parcel data (bright green polygons) 
showing areas that are zoned for retail or public use. CT scanning can focus on 
these areas and ignore other areas, including those zoned for single family 
homes.  

V. TRACKING EACH SCAN 
Within each grid/census tract, be systematic about the buildings being scanned. As 
many as 5-10% of CTs can be hidden in parking lots, on the sides of buildings, under 
trees, and in other hard-to-see places. It is very easy to miss even a large CT if a 
systematic scan method is not being used. A system that was used for the OC 
project (and can be adapted for different users) was to divide up the common objects 
making up the screen (i.e., building rooftops, roads/parking areas, green areas, etc.). 
For each object type, we scanned the screen, moving from left to right in an ordered 
fashion. Once the scan was completed for each object type, we repeated the process 
for the next object type until all objects in the screen were scanned. 
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Example of scanning a school area: 

1. Scan the rooftop(s): Start by looking specifically at the rooftop(s) in the image/area. 
In the below example (Figure 24), the school campus has multiple buildings. Look at 
each rooftop in order (A, B, C, D, etc.) before looking at other things (trees, ground, 
etc.). Note that a closer zoom than the zoom level of the picture below will be 
needed in order to spot CTs. 

 

Figure 24: Scanning rooftops. 

2. After finishing looking at the rooftops, circle the perimeter of each building from an 
oblique view to look for CTs hidden on the sides of buildings. 

A 

B 
C 

D 

E 

G 
F H I 

J 
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Figure 25: Example of oblique images showing sides of buildings, where CTs can 
sometimes be located.  

3. Look at all asphalt/parking areas/dumpsters/small ground buildings (everything gray 
or on the ground that is not grass/green), outlined by the red line in Figure 26. 

 

Figure 26: School buildings, with the path eyes should follow to look for 
asphalt/parking/small ground buildings marked in red. 
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4. Next, look at all the green areas (i.e., grass, trees, etc.), with the path outlined in red 
below (Figure 27). 

 

Figure 27: School buildings with the path eyes should follow to look for CTs 
hidden under trees or on lawns marked in red. 

VI. MARKING PROGRESS 
Regardless of the scan strategy being used (grid or census tract, with or without using 
Landvision data), it is important to mark when each grid cell or census tract cell is 
finished. One way of doing this is to shade in each layer that has been completed 
(Figure 28). Another option is to add pins to grid cells or census tracts after scanning is 
complete (Figure 29). 

Marking each grid or census tract will help to track progress until the entire area of 
interest has been scanned, ensuring that work is not repeated, or areas missed.  
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• Color coding: On the current grid or census tract, right click > ‘Properties’ > ‘Style 
and Color’ > ‘Area’ > ‘Filled and Outlined’ > to change the fill color and 
differentiate between cells that have not been scanned.  

Figure 28: Example of using color coding to shade in scan progress. 

• Adding a pin:  

 

Figure 29: Yellow pins in each grid square indicate which grid squares have been 
completed. 
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D. SCANNING FOR CTS 
After accessing imagery, defining the area of interest, creating a grid model and/or a 
scan strategy, scanning can begin! The following is a general protocol with parameters 
to use when scanning for CTs.  

I. SCAN PARAMETERS 
1. Open the GE project with the area of interest and grid model and zoom to the first 

scan cell. With the scan strategy in mind, start to look at building structures for CTs. 

2. Use the following parameters to ensure scanning is occurring at the proper distance: 

i. Set eye altitude (GE term for zoom resolution) and zoom at a minimum distance 
of 600 feet (about 200 meters). 

i. Click ‘Google Earth Pro’ in the menu bar > ‘Preferences’ > ‘3D View 
Tab’ > and set the unit of measure to feet, miles (or meters, 
kilometers). 

ii. Under the ‘View’ tab > check the box for ‘Status Bar.’ 

1. Elevation and coordinates will appear on bottom right of the 
screen. 

2. Zoom into the first grid and scan for CTs with an eye altitude 
of about 600 feet (Figure 30). 

 

 

 

 

 

 

 

 

 

 

 
Figure 30: CT from about 600 feet eye altitude in GE. 



46 
 

ii. Adjust tilt view to look directly parallel to ground surface. (Quickly do this by 
hitting Control + R or Shift + Up arrow on keyboard.)  

a. Use the keyboard arrows to move left and right as you scan. 

b. Examine the sides of buildings by titling the view up or down. This will help 
to identity potential side fans on CTs (Figure 31).  

 

 

 

iii. Under ‘Layers’ > select the checkbox for ‘3D Buildings.’ Turn off all other layers 
except ‘Terrain’ and ‘3D Buildings.’  

iv. Ensure the time slider displays the most current satellite image.  
v. In the top menu bar, make sure that the ‘Show Historical Imagery’  tool is not 

selected. 

 

 

  

Figure 31: CT found using tilt view in GE for a side view. 
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II. COOLING TOWER IDENTIFICATION GUIDE 
A question that should be asked repeatedly and often is, “Is that fan unit actually a 
cooling tower?” Identifying whether a structure is a CT or not is one of the most difficult 
and important tasks in the entire CT-identification process.  

As such, please now see the Cooling Tower Identification Guide supplement for tips, 
suggestions, and examples on distinguishing between CTs and non-CTs on satellite 
and aerial imagery. This section is an adjunct but is an important and useful section that 
was extracted to a supplemental document due to the number of photos included and 
potential usefulness as a standalone document.  

After reviewing the supplemental document, return to this document and proceed for 
additional steps in the CT-identification process. 

III. EXAMINE OLDER SATELLITE IMAGES FOR COOLING TOWERS  
Historical imagery can be helpful for a few reasons: by providing additional imagery with 
which to confirm that a structure is a CT, and by helping gauge the age of the CT/when 
a CT may have been built. The following are steps for viewing older images in GE.  

1. At the top toolbar click ‘View’ and check the box for ‘Historical Imagery.’ 
a. A slider should appear in the top let corner with the current year. Use the 

tool to slide to historical images, labeled by date of the satellite image.  
b. To exit, uncheck the ‘Historical Imagery’ box in the ‘View’ toolbar options 

or close the box. 
c. The image below (Figure 32) shows the same CT with imagery from 

March of 2015. Use the slider to see how buildings and CTs have 
changed over time. 

  

Figure 32: Historical images toolbar in top left of GE. 

https://www.cdph.ca.gov/Programs/CID/DCDC/CDPH%20Document%20Library/CTIDGuideSupplement.pdf
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E. LABELING COOLING TOWERS 

When scanning and identifying CTs, applying labels and descriptions can later help with 
analyzing project data. The type of labels to add depend on the intended use of the 
data. For the OC project we used:  

• Object Identification Number (OID)  
o Can label sequentially or define a scheme for naming/numbering CTs 

identified 

• Location  

o Ground 

o Roof 

• Number of fan blades 

• Year CT appeared in satellite images between 2014 to 2018 

• Confidence score 

o Low  
o Medium 

o High 

• Size 

o Diameter in meters 

• Building type 

I. LABEL DESCRIPTIONS 
OID is the numerical order for CTs identified. For example, the first CT found from a 
scan was given the ID number 1 and then labeled numerically. This also helped track 
the total number of CTs found in the study area. Different schemas can be designed for 
different needs. For the OC project, we labeled each structure that appeared to be 
independent (i.e., we imagined that an independent CT could be removed, without 
rendering an adjacent CT inoperable) as an individual CT. Another method might be to 
label each cluster of CTs as one CT, regardless of how many independent CT 
structures may be there. It is important to decide on a method of determining an 
independent CT before scanning begins and maintain the same scheme throughout the 
scan process for consistency (Figure 33).  
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Figure 33: Cluster of CTs on a rooftop. This could be considered one CT cluster, 
three CT groups, or six independent CTs. Numbering schema should be 
consistent throughout your identification process. 

• Location is the physical location of a CT (whether on top or side of a building, or 
on the ground). This was included since the distance that CT drift can reach may 
vary if a CT is on the ground or on top of a building. Consideration could be given 
to approximate height (i.e., 50 story building versus two story building). 

• Number of fan blades can be determined by counting the number of circular 
fans on each CT base. Most round CTs have only 1 CT fan, while square and 
rectangular CTs often have sets of two, four or six fans. This is also important, as 
it is sometimes difficult to determine what constitutes a single CT unit. Some 
units may have six very large fans, while others may only have one small fan.  

• Year CT appears included the earliest year a CT was found present in CT 
images, using the time slider option on GE. For the initial study we viewed 
images from 2014 to 2019. If the CT was present before the study period, it was 
given the earliest study date of 2014.  

• Confidence score was used as a measure for rating the scanner’s overall 
confidence that a CT was actually present at a location marked. We used scores 
of low, medium, and high. These categories were subjective, and a means to 
mark CTs for later discussion or review with another scanner. CTs marked with a 
confidence score of ‘High’ were those for which the scanner was highly confident, 
and thus did not need review by another scanner. ‘Low’ confidence CTs were 
those that were not clearly CTs and were all reviewed by another scanner for a 
second opinion. ‘Medium’ confidence CTs were thought to likely represent a CT 
but were still reviewed by another scanner after all ‘Low’ confidence CTs were 
first reviewed.  

• Size was recorded as both diameter of fan in meters and a qualitative size 
category (i.e., small, medium, large). Qualitative categories can be adjusted 
based on distribution of diameters of CT fans found within each project. 
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II. ADDING LABEL DESCRIPTIONS 
When a structure that appears to be a CT is found, drop a pin to mark the location and 
add a label description. 

1. Right click on the folder name under ‘My Places’ > ‘Add’ > ‘Placemark’ 
a. A text box and a yellow box will appear. 
b. Move the yellow box on the map to the location of the identified CT. 
c. Under the ‘New Placemark Name,’ label the object ID for the CT. 
d. To change the placemark symbol or color, click the ‘Placemark’ symbol 

next to the name 
2. Under the description box, add more specific labels. 

a. When adding descriptions, we separated values with a comma for future 
data cleaning. There is no need to add label headers, only the values for 
each label. 

b. Figure 34 shows the OID for CT number 7 from the OC project, and 
descriptions as: Location=roof, Number of fans= 2, Confidence= high, 
Year available= 2014. 
  

 
 

 Figure 34: Adding a placemark and label descriptions. 
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III. TAKING SNAPSHOTS (OPTIONAL) 
Adding pictures of each CT as an additional label may be useful to create a repository 
of CT images found. Note however that this may consume a lot of memory / disk space 
and may not be necessary for many projects. The below steps outline how to take and 
label snapshots.  

1. After adding a placemark label, take a screenshot of the CT in GE. 
2. Select the label for a CT for which an image has been identified > ‘Get Info’ > 

‘Add’ > ‘Local Image’ > navigate to the screenshot. 
3. Whenever the CT is selected, the image and label descriptions will appear 

(Figure 35).  

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 35: Example taking screenshots for additional label descriptions. 
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3. POST-SCAN 

A. CONVERTING DATA PRODUCTS 
 

I. CONVERTING GOOGLE EARTH FILES FOR GIS ANALYSIS IN ARCMAP  
While GE is an excellent GIS program, it is less ideal for analysis. Thus, users may 
want to export GE files into another GIS program (e.g., ArcGIS) for analysis. 

1. In GE, first save the CT layer as a KMZ file. In GIS programs, layers are 
generally a distinct set of data (either a raster/picture, points or polygons) that is 
‘layered’ over a base map (i.e., the satellite image of an area). For this project, 
the CT pins are a point layer. 

a. Each folder under ‘My Places’ in GE can be considered one layer. The 
CTs towers should be individual pins, but all organized under a folder 
within ‘My Places.’ If the CTs are not within a folder, then each CT is 
considered an individual layer.  

i. To organize CTs into a folder, first create a folder. 
1. Right click ‘My Places’ > ‘Add’ > ‘Folder’  

a. Name the folder ‘Cooling Towers’ 
ii. Drag all CT pins into the ‘Cooling Towers’ folder. 

b. Right click on the folder containing the CTs > ‘Save Place As',’ and 
choose the .kmz file extension to save in. 

2. Open ArcMap 
a. Use ‘Toolbox’ > ‘Conversion Tools’ > ‘Convert from KML to Layer.’ 

Refer to the Tufts GIS Center resource for detailed instructions on Google Earth file 
conversion (http://sites.tufts.edu/gis/files/2013/11/GoogleEarthTutorial_kml-
shp_conversion1.pdf). 

II. GEOCODING COOLING TOWER POINTS 
If the KML file is not already georeferenced, or additional data needs to be geocoded 
(i.e., legionellosis cases) with known latitude / longitude coordinates, then start by 
geocoding the points for it to be spatially recognized in ArcGIS.   

1. Geocode the X,Y,Z coordinates for the attribute table. 
a. ‘Toolbox’ > ‘Data Management Tools’ > ‘Features’ > ‘Add XY Coordinates’ 

> Select the current table in ArcMap from the KML conversion.   
b. Exit the toolbox. 

http://sites.tufts.edu/gis/files/2013/11/GoogleEarthTutorial_kml-shp_conversion1.pdf
http://sites.tufts.edu/gis/files/2013/11/GoogleEarthTutorial_kml-shp_conversion1.pdf
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Figure 36: Example showing the ‘Add XY Coordinates’ function in the ArcGIS 
‘Toolbox.’  

 

 

Figure 37: Window in which to select table for the ‘Add XY Coordinates’ function.  
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III. EXPORTING TO MICROSOFT EXCEL FOR DATA CLEANING 
(RECOMMENDED) 
While data in ArcGIS can be viewed and edited by using the attribute table (a 
spreadsheet attached to each layer), it is best to do non-spatial data cleaning and 
manipulation in a separate program and then re-import into ArcGIS (using the steps 
from II. GEOCODING COOLING TOWER POINTS above).  

1. Navigate to the ‘Toolbox’ > ‘Conversion Tools’ > ‘Excel’ > ‘Table to Excel.’ 
2. ‘Input Table’ = the labeled file in ArcMap (which should now include X and Y 

coordinates for all CT points). 
3. ‘Output Excel File’ = Name the file. 

CONVERTING DATA IN MICROSOFT EXCEL 
When cleaning data, be sure to properly label each column, convert the CT labels 
created in GE, and ensure that erroneous data are removed or corrected. 

1. Open Excel and navigate to the Excel file exported from ArcPro or ArcMap. 
a. Remove columns that are not needed (i.e., Folder Path Column, Symbol 

ID, AltMode, Base, Snippet, HasLabel, LabelD). 
b. Convert the CT label data into different columns. 

i. Move ‘PopupInfo’ Column to be the last column in the dataset. 
ii. Select the entire column > ‘Data > ‘Text to Columns’ > Choose 

‘Delimited’ and click ‘Next.’  
iii. Under ’Delimiters’ select the check boxes for ‘Tab’ and ‘Comma’ 

then click ‘Next.’  
iv. Select ‘General’ and click ‘Finish.’ *Column labels separated out 

should now be visible 
c. Relabel columns, if desired. 

2. Data cleaning and quality checks can now be done to look for missing or 
erroneous data. The specific steps needed for this are similar to other data 
cleaning. 

B. ITERATIVE PROCESS 

Quality assurance is an important part of the CT identification process. Depending on 
the goals of the CT project, differing levels of quality assurance can be taken. While 
specific steps taken for quality assurance may vary depending on size and goals of the 
project as well as available staff, they should generally target the following areas: 

1) Re-scanning areas to ensure no CTs are missed 
2) Ensuring that CTs identified are actually CTs 
3) Data validity 
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I. RE-SCANNING AREAS TO ENSURE NO COOLING TOWERS ARE 
MISSED 
The goal of re-scanning is to make sure CTs are not missed. CTs are easily missed, 
especially if scanning areas that are large, or early on in the scanning process, while 
building experience identifying CTs. If multiple people are available, re-scanning can 
involve randomly selecting areas for multiple people to re-scan without knowing where 
CTs have already been identified by others. If multiple scanners are not available, then 
blinding earlier results and re-scanning random grids/census tracks at the end of the 
projects might be a reasonable approach.  

For the OC project, a second scanner independently reviewed ten percent of census 
tracts, which were randomly selected.  

II. ENSURING THAT OBJECTS IDENTIFIED ARE ACTUALLY COOLING 
TOWERS 
One of the most difficult parts of the CT scanning process is identifying what constitutes 
a CT. At the very least, for quality assurance purposes, all CTs labeled as ’Low’ 
confidence should be reviewed with another scanner. If another scanner is not 
available, then other experts (i.e., environmental health specialists familiar with CTs) 
can be recruited, with images reviewed together. If time permits, all, or a subset of 
‘Medium’ confidence CTs should also be reviewed. 

Depending on project goals, ground truth verification can also be very important as the 
presence of a CT on a satellite does not guarantee it is truly a CT or that it is 
operational/being used. Verification can take the form of physically visiting CTs to verify 
or calling buildings to ask about the presence of CTs. Both are time-intensive processes 
with their own limitations. Physically visiting structures may be fruitless as CTs may be 
behind locked doors or on top of high-rise buildings or otherwise obscured. Calling 
buildings may also be misleading as some building personnel may not know what a CT 
is or may not want to share that information. However, ground truth verification can be 
very important to verifying the presence or absence of CTs and validate scanning 
techniques. 

III. DATA VALIDITY 
Data validity is an important quality control measure for any dataset; cross-checking 
labels during the quality assurance and re-scanning processes and ensuring that 
identified objects are actually CTs are important ways to validate data. Other standard 
procedures for reviewing data should also be established and used. 
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C. LIMITATIONS OF SATELLITE IDENTIFICATION 

Satellite imagery is not a perfect method for finding all CTs in a geographical area. 
Using aerial and satellite images disregards CTs that can be inside or within buildings. 
This method is biased towards larger CT structures that can be seen on satellite images 
rather than smaller CTs that may require greater spatial resolution to find. Additionally, if 
satellite images for CTs are covered by other building structures or vegetation, such as 
large trees masking a building, it will be harder to find a CT using this method. We are 
unaware of any other identification process to identify closed-circuit CTs using satellite 
imagery and are therefore limited to scanning for open-circuit CTs with fans. Satellite 
images are also dated; new CTs may not appear and older CTs may have been 
removed by the time the image was acquired. In addition, presence of a CT on an 
image does not indicate whether the CT is operational. For the OC project, we assumed 
that anywhere from 5-30% of CTs could be missed during the scanning process.  

 

4. GENERAL RECOMMENDATIONS  

1. Start with a pilot study area: Refining and replicating a CT scan can be very time 
consuming and is much easier if scanners start with a small region within the study 
area for a practice or pilot scan. Starting with a pilot area allows scanners to refine 
methods before spending a lot of time learning to scan and label.  

2. Reduce the area that needs to be scanned: 
Methods that help to reduce the area that needs to be scanned (i.e., using 
Landvision building parcel data) can substantially reduce the amount of time needed 
as well as reduce fatigue and thus errors. Spend time focused on higher risk areas 
(i.e., hospitals, identified by appearance on satellite imagery or by building parcel 
data) but be careful not to ignore other areas. 

3. Save the GE file: Do not try to save the GE file by clicking > ‘File’ > ‘Save As.’ This 
will not store the locational data and layers. Instead, save the data specifically: 

o Keep the data (pins) organized in layers (folders) in GE. For instance, for 
CT data (pins): 

i. Create a folder by right clicking ‘My Places’ > ‘Add’ > ‘Folder,’ and 
name the folder ‘Cooling Towers.’ 

ii. Drag all CT pins into the ’Cooling Towers’ folder. 
o Save the data within layers (folders) as a KMZ. Whenever there are data 

within ‘Layers’ (folders), Navigate to ‘My Places’ > right click the layer > 
‘Save As’ > name of file.   

4. Use multiple CT scanners: Have more than one individual scan the same area of 
interest to compare findings and consolidate datasets. This helps with limiting bias 
for only one scan. Further, we used confidence scores to prioritize which CTs should 
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be re-validated/cross-checked. For instance, all CTs with ‘Low’ confidence scores 
were re-validated first, and then all ‘CTs with ‘Medium’ confidence scores were re-
validated. ‘High’ confidence CTs were not re-validated.  

 

5. ADDITIONAL RESOURCES 

CT-related Articles 

• “Back to Basics: Cooling Tower 101” https://blog.senseware.co/2018/02/06/back-
basics-cooling-towers-101  

• “How Cooling Towers Work: W/Diagram, Pictures, & Principles) 2018” 
https://www.coolingtowerproducts.com/blog/how-cooling-towers-work-diagram-
pictures-2015.htm#7 

• “Buildings Cooling System” 
https://www1.nyc.gov/assets/buildings/pdf/evaporative-_cooling.pdf 

• “What is a cooling tower?” https://www.cti.org/whatis/coolingtowerdetail.shtml 
• “CTI Journal: Official Publication of the Cooling Technology Institute” 

https://www.cti.org/downloads/win10journal.pdf 

Analysis Resources 

• “Prioritizing Cooling Towers Testing Using Routes Walked by Legionellosis 
Patients” https://www.cti.org/whatis/coolingtowerdetail.shtml  

• Databases for shapefiles: 
o Berkeley Library Geodata: https://geodata.lib.berkeley.edu/  
o Data.gov Data Catalog: https://catalog.data.gov/dataset/tiger-line-

shapefile-2017-county-orange-county-ca-all-roads-county-based-shapefile 
 

https://blog.senseware.co/2018/02/06/back-basics-cooling-towers-101
https://www.coolingtowerproducts.com/blog/how-cooling-towers-work-diagram-pictures-2015.htm#7
https://www1.nyc.gov/assets/buildings/pdf/evaporative-_cooling.pdf
https://www.cti.org/whatis/coolingtowerdetail.shtml
https://www.cti.org/downloads/win10journal.pdf
https://www.cti.org/downloads/win10journal.pdf
https://www.cti.org/whatis/coolingtowerdetail.shtml
https://www.cti.org/whatis/coolingtowerdetail.shtml
https://geodata.lib.berkeley.edu/
https://catalog.data.gov/dataset/tiger-line-shapefile-2017-county-orange-county-ca-all-roads-county-based-shapefile
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